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BOOST FREQUENTLY ASKED QUESTIONS / TECHNICAL SUPPORT

Mac OSX the installation does not start.

Problem: On a Macintosh system when the program installation button is clicked, the installation does not start (the
installation screen stays there).

Solution: Make sure you are logged in as the Administrator of the computer and then install the program.

Installation Instructions (Standalone version).

Problem: How do i install the BOOST Maths program on the local hard drive?

Solution
* Both Windows and Macintosh versions are present on the CDROM, however, because of the way the CD is constructed,

you will only see the files for your operating system.

Windows Installation:
1. Insert the CD into the CD drive of your computer.



2. The CD should Autorun (start automatically).

3. If the CD does not autorun, click on the "START" button, then "RUN", then "BROWSE" , then navigate to your CD drive
where the BOOST CD is located. Find the Installer file and click on it, then click " OPEN", then "OK".

-This will start the installation process. Once the setup starts, follow the on-screen instructions to install the program.

Mac OSX:
1. Insert the CD into the CD drive. The CD icon will appear on the desktop of your computer.
2. Double click on the CD icon on the Desktop to open it.
3. Now double-click on the Installer icon to start the installation of the program. Follow the prompts to complete the
installation.
4. To start the program double click on the program icon on your hard drive.
The software will NOT run from the CD.

Read - Write access errors on Mac OSX

Problem: Read-Write access error when trying to run a program.

Explanation

* To control access to your important information, Mac OS X automatically sets permissions for disks, folders, and files. You
can change these permissions for an item using the Info window in the Finder so that users can run and save certain
programs.

Solution: Setting permissions:
You can change permissions for an item using the Info window in the Finder.
Mac OS X provides distinct permissions for three types of users:

The "owner" of the item, which is usually the name of the person who created the item, or yourself
Any member of the group assigned to the item by Mac OS X
Any other user with access to the computer

There are four levels of permission:
1. Read & Write allows a user to open the item to see its contents and change it.
2. Read Only allows a user to open the item to see its contents, but not change the contents or copy them.

3. Write Only makes a folder into a drop box. Users can copy items to the drop box, but cannot open the drop box to see
its contents. Only the owner of the drop box can open it to take items out.

4. No Access blocks all access to the item so that users can't open the item, change its contents, or copy its contents.
To change permissions for a disk, folder, or file:

Select the item you want to set permissions for, then choose File > Get Info and click Ownership & Permissions, if
necessary. If you want to set permissions for multiple items at once, select them, and as you hold down the Control key
choose File > Get Summary Info.

Choose a permission for yourself from the pop-up menu. If the menu is dimmed, you don't have permission to change this
setting.

To change permissions for the owner, group, or others, click Detail. If necessary, click the lock icon and, when prompted,
enter the name and password of an administrator user of your computer.

Choose permissions for each type of user from the Access pop-up menus.

The pop-up menu at the top of the Ownership & Permissions pane tells you the access privileges you have for the
selected item. If you are the owner, you can use this menu to change your access privileges.

If you want to apply the same permissions to every item contained in the selected folder or disk, click "Apply to enclosed
items".



Error: 16 Bit Windows Subsystem C:WindowsSystem32Config.NT.

Problem: When trying to load any program into XP, | get the following message:
16 Bit Windows Subsystem C:WindowsSystem32Config.NT. The system file is not suitable for running MSDOS and
Microsoft Windows applications. Choose "Close" to terminate the application.

Solution: The problem seems to be that the file Autoexec.NT is missing from the directory Windows/system32. This can
happen when installing SP2 or possibly when running some anti-spyware programs.
Copy Autoexec.NT from windows repair and paste it in Windows/system32 then right click on it and made it read only.

Computer freezes

Problem: Computer freezes after using the program for sometime.

Solution: There are many reasons why a computer may freeze. The most common reason is an overload in the memory.
Computers have a set amount of memory to work with (this is their RAM, or "Random Access Memory"). If you attempt to do
more with the computer than it's capable of handling at one time, it may "freeze" in an attempt to save itself. Generally, the
cause of this is generally that too many programs are running at once for the computer to handle. If you are not using a
program, close it.

Conflicts between programs are other well-known reasons for crashes.

Programs such as virus detectors are notorious for conflicting with other applications and utilities. If you notice that
crashes are occurring while the same two programs are running, try to avoid running these two programs at the same time.

Try to End the Programs running in the background. Windows provides a "Task Manager" that lists all current programs in
operation. In Windows 9x/Me/XP, this menu is brought up by pressing Ctrl + Alt + Delete at the same time. In Windows 2000,
after pressing Ctrl + Alt + Delete, click the "Task List" button. In this menu, you can attempt to individually close programs that
are causing problems. If programs are unresponsive, Windows will attempt to notify you of this in the Task Manager

Corrupted windows, video drivers or sound drivers will cause problems.

Reinstalling windows would be a last option if all else fails. Also make sure you have latest video and sound drivers.

With Geforce cards, another option is installing an earlier set of drivers. Its possible the current drivers could be unstable
for your system.

Excessive heat buildup inside the system cpu or video card heating up while playing graphic intensive games after
sometime is another common reason why systems freeze.

Ways to resolve the issue:

Run software diagnostic tests like Norton Windows Disk Doctor or Norton's System Tools.

End the Programs running in the background by pressing Ctrl + Alt + Delete at the same time and closing the background
applications.

You need to select each file and click on the End Task button. (Do not do this for the Explorer or Systray files, as you
need these files to run Windows).

You will need to repeat this process until all the files are shut down except for the 2 mentioned above.Then run the
software program that you were having a problem with.

If the issue still doesnt resolve then do the follwing:

Run Windows Disk cleanup.

Defragment the hard drive.

Install the latest Windows updates.

Install the latest Video and Sound drivers.

Video Driver

Problem: How do | update or reinstall Windows video driver?

Solution: An outdated or corrupted video driver can cause display issues. Updating or reinstalling the video driver should
resolve it. View the remainder of this technical note for more information.

The following procedure describes how to collect video driver information, which is needed to update the video driver and
to resolve this issue.



Updating the Video Driver:
NOTE: The driver (make and model information) is found in the Device Manager in the System Properties window.
1. Return to the desktop and right-click once on the My Computer icon. (For Windows XP, click Start and right-click the
My Computer icon.)
2. Using the left mouse button, click Properties in the menu that appears.
3. Click the Device Manager tab in the Systems Properties window.
4. Locate Display Adapters and click on the Plus (+) sign before it.
5. Double-click the driver name that appears. A driver Properties window will open.
6. Click the Driver tab in the window that opens. (The date of the driver currently installed should be displayed.)
7. Record the information.
NOTE: Do not click the Update Driver button in the driver Properties window.
8. Contact the video card or computer manufacturer for additional information.
NOTE: Video driver updates can be obtained from the appropriate manufacturer’'s web site, or by contacting the
computer manufacturer for update and download information.

Customizing Windows 98

Problem: How do | Customize Windows 98 for multiple users ?

Solution: You can setup Windows 98 so it will save custom setting for each individual who uses it by enabling the user logon
feature. The user logon feature will ask for the user’'s name and password when booting up. Once this is entered, Windows
98 will boot with that person’s settings.

To enable this feature:
o Click the "Start" button.
0 Select "Settings"
o Click "Control panel"
0 Once you are there, double-click the "Passwords" icon.
o Click the "User Profiles" tab.
o Click on "Users can customize their own preferences and desktop setting”
o Now reboot (restart) Windows.
0 When the Logon screen comes up, simply enter a name and password.

Now, you can customize Windows the way you want without changing other user’s settings.



Viewing the 'Security' tab in Windows XP Home edition.

Problem: Viewing the Security tab in Windows XP home edition.

Solution: If you are using XP Home edition and you dont have a Secuity tab, then do the following to view the Security tab.
Viewing Security Tab (for Windows XP home).
If you are using Windows XP home you will need to restart your computer in safe mode in order to view the security tab.
This is done by restarting your computer, then hold down the F8 key as soon as the opening screen appears. A menu will
the appear, select "Safe Mode" from this menu. Right click on a file or folder for which you want to set the security settings
and you will see the Security tab.
You might have to Login as the Administrator to make the changes.

Error: 'This program has performed an illegal operation and will be shut down'.
Problem: This program has performed an illegal operation and will be shut down.

Solution:You may have a conflict or a lack of system resources. Please re-install the program again as follows.

Un-install the program.

Reboot the PC.

Make sure you have a minimum 100 - 500 MB of free memory on your (Local C:) Drive.
Disable any Anti-Virus and Firewall programs that you have running.

1.0pen My Computer.

2.Right-click the disk you want to free space on, and then click Properties.

3.0n the General tab, click Disk Cleanup.

4.Click the files you want to remove( Temp files,Temp Internet files,Recycle bin, etc.) and then click OK.

Note: You can read a description of each file type in the area under the list. Before running the program you should
ensure that all programs are shut down, to do this please follow the instructions below:

1) Hold down CTL/ALT/DEL buttons on your keyboard. This will bring up the Close Programs screen.

2) You need to select each file and click on the End Task button. (Do not do this for the Explorer or Systray files, as you
need these files to run Windows).

You will need to repeat this process until all the files are shut down except for the 2 mentioned above.

Re-install the program

Creating a Shortcut
Problem: How do i create a program shortcut icon on Windows desktop?

Solution: To create a shortcut icon on the desktop, click on the Start menu then go to programs, then go to the name of the
program that you want to create the short for and click on it with the right mouse button and select "Create shortcut” or "send
to" Desktop.

A shortcut will now be created for that program on the desktop screen.

Not a valid win32 application’.
Problem:When you run the program you get an Error message: "Not a valid win32 application”.

Solution: This can happen if the program installation gets corrupted.
Resolution: First uninstall the program.
Empty the Temp files folder.

To empty the Temp folder and the Temporary Internet Files folder, use the Disk Cleanup tool. To do this, follow these
steps:



1. Click Start, point to Programs, point to Accessories, point to System Tools, and then click Disk Cleanup.
2. Click C: (or whatever drive on which Windows is installed), and then click OK.

3. Click to select the Temporary files check box.

4. Click OK, and then click Yes to confirm the deletion.

Perform a Manual Install of the program.

How do | create a program shortcut icon on the desktop for All Users on
Windows 2000 or XP ?

Problem: Standard users don't have a shortcut icon on their desktop for the installed program

Solution: 1. Login as the Administrator of the computer.
Open My Computer or Windows Explorer, and go to the following directory:

C:\Documents and Settings\All Users\Desktop.
2. Go to the File Menu and select New, and then Shortcut.

3. In the "Create Shortcut" window that appears, click Browse and select My Computer.

You will now need to browse to the Program Files folder, then the program folder for which you want to create a shortcut.
Within that program folder, open the .exe file (application file) for which you would like to create the shortcut (for e.g.
NumbersUp.exe).

Note: If you installed to a different location instead of C: , you will need to navigate to that location.
4. Select .exe file, click OK, and then click Next.
5. Click "Finish." The shortcut should now appear on the desktop. It will now be present for All users of that computer.

Note: Make sure the program folder you are creating a shortcut to has Full-Control for all Users or you might get read-
write access errors for standard users.

error: 'Set handle context entry point’
Problem: "Set Handle Context entry point" Error

Solution: You can fix this error by emptying the Temporary folder on your computer.

Follw these instructions:
1. Start menu -->
2. Programs -->
3. Accessories -->
4. Disk cleanup
5. Select your Hard drive (Eg. drive C). (Make sure Temp internet files box is ticked, then click ok. This should empty
the temporary files on the system.)
You might need to install the program manually. Click on this link to see instructions for a Manual Install



Changing Screen Colors

Problem: How do i change the number of colors displayed on my monitor?
Solution: To change the number of colors displayed on a monitor(on XP)
1. Open Display in Control Panel.
2. On the Settings tab, in the Color quality list, click a different color setting.
Note
To open Display, click Start, click Control Panel, click Appearance and Themes, and then click Display.

Choose Medium to display over 65,000 colors, High to display over 16 million colors, and Highest to display over 4 billion
colors. Choosing more colors provides better color quality on your screen.

Settings that display a larger number of colors normally require more computer memory and might affect performance on
older computers.

You can switch your color quality temporarily to 256 colors if you have games or other programs that perform better or
must run at that level. To switch to 256 colors, right-click the game or program (on the desktop or on the Start menu), and
then click Properties. Click the Compatibility tab, and then select the Run in 256 colors check box. Your display reverts to its
default color quality when you close the program.

Your monitor and video adapter determine the color settings that are available for your screen.

Changes to the color settings affect all users that log on to the computer.

Only the recommended color settings are listed. For additional settings, click the Advanced button on the Settings tab,
click the Adapter tab, and then click List all Modes. Select the resolution, color level, and refresh rate you want.

If you are using multiple monitors, you can specify the color settings for each installed monitor. If you click the icon for a

secondary monitor, the Extend my Windows desktop onto this monitor check box must be selected to change the settings for
that monitor.

Icons & text do not appear normal

Problem: When the size of the icon and text appears small on the computer screen.(This applies to windows XP)
Solution: To increase or decrease the size of objects and text on your screen

1. Open Display in Control Panel.

2. On the Settings tab, click Advanced.

3. On the General tab, in the DPI setting list, click the dots per inch (dpi) setting you want to use.

4. If you choose Other in the DPI setting list, you can set custom options in the Custom DPI Setting dialog box either by
selecting one of the percentage options in the drop-down list or by clicking on the ruler and dragging the pointer to specify a
setting.

5. Restart your computer when prompted.

Note

To open Display, click Start, click Control Panel, click Appearance and Themes, and then click Display.

If you want to increase the size of text on your screen to make it more readable, use Font size on the Appearance tab in
Display Properties.



The dpi size you specify on the General tab affects all monitors attached to your computer and all users that log on to the
computer

Using Safe Mode in Windows

Problem: Installing Programs in Safe Mode (Windows 2000/XP)
To minimize conflicts that can occur during an installation, starting (or booting) your Windows 2000 or Windows XP.

Solution: The procedure below describes how to boot your system in Safe Mode and install a program.
To install a program while in Safe Mode, follow the procedures below in the order they are presented.

NOTE: When a computer boots in Safe Mode, the time to startup will take longer and what appears on the startup screen
will be
different. This is normal when booting in Safe Mode.

Shut Down the Computer

1.Close all open windows and programs.

2.Click Start (typically located in the lower-left corner of the screen) and click Shut Down. A Shut Down Windows window
will

appear.

3.Click the down arrow under “What do you want your computer to do?” and select Shut down.

4.Click OK. The computer will shut down.

Boot the Computer in Safe Mode

1.Press the power button on the computer to start it.

2.While the computer is starting up, repeatedly press and release the F8 key on the keyboard. The F8 key is located
above the

number keys on the keyboard. A Windows Advanced Options Menu will appear.

NOTE: A keyboard error may occur if you begin to tap the F8 key too soon. If this happens, restart the computer and try
again as the system boots up.

3.After the Advanced Options Menu appears, click the UP ARROW key on the keyboard several times until Safe Mode is
selected and press the ENTER key on the keyboard. A "Please Select the Operating System to Start" window will appear.

For Windows 2000, click the UP ARROW on the keyboard (if needed) until Microsoft Windows 2000 is
selected and press the ENTER key on the keyboard.

For Windows® XP, click the UP ARROW on the keyboard (if needed) until Microsoft Windows XP
Professional or Microsoft Windows XP Home is selected and press the ENTER key on the keyboard.

Windows® will load. During this process, several lines of text will appear on the screen.

4.If prompted, press and hold the CTRL and ALT keys on the keyboard and press the DELETE key once to begin the
Windows®

login process.

5.Enter the administrator user name and password into the fields provided and click OK. A message window will appear
stating

that Windows is running in Safe Mode.

6.Click Yes. The Windows® desktop will appear with “Safe Mode” in all four corners of the screen.

Install the Program

1.Insert the proper CD/DVD into the CD/DVD-ROM drive.
2.Follow the onscreen instructions to complete the installation of the program.

NOTE: Some programs cannot be installed when the computer is running in Safe Mode. If a message appears indicating



that an error has occurred, close the message and continue with Restart the Computer Normally. You will be unable to install
the program with the computer running in Safe Mode. Consult the documentation included with the program for installation
instructions.

If the autorun screen does not appear and the installation does not begin, complete the following as needed:
Verify that the correct disc has been inserted into the proper drive and try the installation again.

Check the surface of the disc for damage or smudges, etc., clean the disc (if needed), and try the
installation again.

If the installation does not begin, click Start and click My Computer. Right-click the CD/DVD-ROM drive
icon representing the driver where the disc was inserted, and choose Open from the menu that appears.
Locate and double-click the Setup.exe file to initiate the installation. If no Setup.exe file is found, continue
with the next suggestion.

Consult the documentation included with the program for additional installation instructions.
3.After the installation is complete, restart the computer in normal mode using the procedure that follows.
Restart the Computer Normally

1.Click Start and click Shut Down.
2.Click the down arrow by “What do you want the computer to do?” and select Restart.
3.Click OK. The computer will restart normally.

Display does not appear right or the screen splits in half or moves to one
side.

Problem: When starting the program the display does not appear right on the screen.
Explanation

* Lowering Video Hardware Acceleration (Windows XP/2000) settings sometimes fixes some display issues that occur
while running programs.

Solution: Lowering video hardware acceleration can resolve some display issues that occur while running programs.
Complete the steps that follow to lower the video hardware acceleration on a system running Windows 2000 or Windows XP.

1.Close programs and all windows and return to the desktop.

2.Right-click a blank area on the desktop and left-click Properties from the menu that appears. The Display Properties will
open.

3.Click the Settings tab.

4.Click the Advanced button.

5.Click the Troubleshoot tab. A window will open with the display adapter type identified on the title bar.

6.Locate the hardware acceleration adjustment bar. (It will show the words None and Full at each end.)

7.Record the current setting.

8.Position the mouse pointer on the hardware acceleration slide bar and click the mouse button, keeping the button
pressed.

9.By moving the mouse, move the hardware acceleration slide bar to the left one position and release the mouse button.

NOTE: Do not select the NONE setting, which is the setting to the far left.

10.For the new setting to take effect, click Apply and then click OK.
11.Click OK again to close the Display Properties window.
12.Launch and use the program.

NOTE: If the issue remains, repeat the above procedure and move the hardware acceleration slide bar to the left one
additional position.
(Do not select the NONE setting, which is the setting to the far left.)



After closing the program, return to the Hardware Acceleration adjustment area of the Troubleshoot Tab (see above) and
reset the
hardware acceleration to the original setting.

If lowering the hardware acceleration improved program performance, repeat the above procedure before launching and
using the
program.

Also update the Video driver on the system and try changing the screen resolution and colour settings of the computer.
See video related tech questions on our web site.

How to use Compatibility Mode in Windows XP

Problem: Program is not starting and comes up with "This Application cannot run error".
Solution: Running Programs in Windows® XP Using Compatibility Mode

Most programs run properly on Windows® XP. The exceptions include some games and other programs that were written
specifically for
an earlier version of Windows®. The Program Compatibility Wizard can allow older programs to run on Windows® XP.

The Program Compatibility Wizard prompts you to test the program in different modes (environments) and with various
settings. For

example, if the program was originally designed to run on Windows® 95, set the compatibility mode to Windows® 95 and
try running the

program again. If successful, the program will start in that mode each time. The wizard also allows the use of different
settings, such as

switching the display to 256 colors and the screen resolution to 640 x 480 pixels.

The Program Compatibility Wizard provides step-by-step instruction for use. To run the Program Compatibility Wizard,
complete the
steps below.

NOTE: Windows® XP allows different options for viewing graphical interface. The following procedure assumes that the
default
Windows® XP view settings are used, rather than the Classic Start Menu View.

1.Close programs, return to the desktop, and click Start on the Windows® taskbar.

2.Click All Programs, choose Accessories and select Program Compatibility Wizard. The icon appears as a question mark
(?).

The Program Compatibility Wizard Welcome window will open.

3.Click Next.

4.Click the "I want to choose from a list of programs" radio button. A list of programs will appear.

5.Select the program that is to run in a Compatibility Mode.

6.Click Next. A window presenting the different Windows® Compatibility Modes will open.

7.Click the radio button next to the desired Compatibility Mode and click Next. The window that appears allows for the
selection

of 256 Colors and/or 640 X 480 Pixel Screen Resolution.

NOTE: These display settings are not available options in Windows® XP. They are only available when running a
program in

Program Compatibility Mode. The only reason to choose either of these settings is if you are experiencing difficulty
installing

or running an older application designed to run in MS-DOS®, Windows® 3.1 or Windows® 95. If all options remain
unchecked,

then the current Colors and Screen Resolution settings will not be altered.

By default, Windows® XP uses visual themes that may change the appearance or behavior of other programs, especially
those games or educational programs that include intensive graphics and animation. To prevent the visual themes from
affecting these programs, check Disable Visual Themes.



8.Click Next. A window showing the heading "Test Your Compatibility Settings" will appear. In addition, the settings that
you

selected will appear.

9.Verify that the settings are correct.

NOTE: If the settings are not correct, click the Back button to return to the previous screen (or screens) and make the
necessary changes.

10.With the correct settings selected and showing in the "Test Your Compatibility Settings" window, click Next. A screen
showing the following question will open: "Did the program work correctly?" In addition, the program selected in Step 5
(above) wil launch.

11.Run the program to test the settings.

12.After testing the settings, minimize (or close) the program to return to the Program Compatibility Wizard.

NOTE: After the program is minimized (or closed), the window with the "Did the program work correctly?" question will
reappear.
The "Yes. Set this program to always use these compatibility settings" will be selected.

13.If the program functioned properly using the compatibility mode that was selected in Step 7 (above), click Next. The
Program
Compatibility Data window will open.

NOTE: If the program did not function correctly, click "No, try different compatibility settings” and complete the Wizard.
After completing the wizard, try the program again.

14.In the window that opens, select Yes or No and click Next. The Completing the Program Compatibility Wizard window
will appear.

15.Click Finish to close the window.

16.Launch (if necessary) and use the program.

NOTE: If you have questions regarding the Program Compatibility Wizard or Windows® XP (or both), contact Microsoft®,
or go to http://www.microsoft.com for additional information.

Error: KRNL386.EXE

Problem: When trying to install the program the following error appears:
"Install has caused an error in KRNL386.EXE"
(applies to Windows 95/98/Me & Windows XP)

Solution: Install has caused an error in KRNL386.EXE
There could be a conflict or a lack of system resources. Please re-install it again as follows:
Windows 95/98/Me
Un-install the program
Reboot the PC
Make sure you have 100MB of free memory on your (C:) drive
Disable any Anti-Virus and Firewall programs that you have running
Delete your Temporary files:
1) Double click on the My Computer icon.
2) Double click on your C: drive.
3) Double click on the Windows folder.

4) Double click on the Temp folder.
5) Go to the Edit menu and select All.



6) Go to the File menu and select Delete.
7) Click on Yes.

Delete your Temporary Internet files:

1) Double click on the My Computer icon.

2) Double click on your C: drive.

3) Double click on the Windows folder.

4) Double click on the Temporary Internet files folder.
5) Go to the Edit menu and select All.

6) Go to the File menu and select Delete.

7) Click on Yes.

Before running the program you should ensure that all programs are shut down, to do this please follow the instructions
below:

1) Hold down CTL/ALT/DEL buttons on your keyboard. This will bring up the Close Programs screen.

2) You need to select each file and click on the End Task button. (Do not do this for the Explorer or Systray files, as you
need these files to run Windows).

You will need to repeat this process until all the files are shut down except for the 2 processes mentioned above.

Re-install the program

Windows XP

Un-install the program

Reboot the PC

Disable any Anti-Virus and Firewall programs that you have running

Delete all you Temporary files and Temporary Internet Files
1. Click Start

2. Click Programs

3. Click Accessories

4. Click System Tools

5. Click Disk Cleanup

6. On the following box Click OK (When your hard drive is selected in the drop down box)
7. Wait it could take a while

8. Make sure all the boxes are ticked

9. Click OK

10. Click Yes on the following box

Before running the program you should ensure that all programs are shut down, to do this please follow the instructions
below:

1) Hold down CTL/ALT/DEL buttons on your keyboard. This will bring up the Windows Task Manager screen.
2) On the APPLICATIONS window you need to select each file and click on the End Task button.

Re-install the program

'General Protection Fault'

Problem: Running the program causes this error message to apprar "General Protection Fault in Module ****** EXE at ****"

Solution: You may have a conflict or a lack of system resources. Please re-install it again as follows:
Un-install the program



Reboot the PC

Make sure you have 100MB of free memory on your (C:) drive
Disable any Anti-Virus and Firewall programs that you have running
Delete your Temporary files:

1) Double click on the My Computer icon.

2) Double click on your C: drive.

3) Double click on the Windows folder.

4) Double click on the Temp folder.

5) Go to the Edit menu and select All.

6) Go to the File menu and select Delete.

7) Click on Yes.

Delete your Temporary Internet files:

1) Double click on the My Computer icon.

2) Double click on your C: drive.

3) Double click on the Windows folder.

4) Double click on the Temporary Internet Files folder.
5) Go to the Edit menu and select All.

6) Go to the File menu and select Delete.

7) Click on Yes.

Before running the program you should ensure that all programs are shut down, to do this please follow the instructions
below:

1) Hold down CTL/ALT/DEL buttons on your keyboard. This will bring up the Close Programs screen.

2) You need to select each file and click on the End Task button. (Do not do this for the Explorer or Systray files, as you
need these files to run Windows).

You will need to repeat this process until all the files are shut down except for the 2 processes mentioned above.

Re-install the program

CD not recognized
Problem: CD/DVD Is Not Recognized (Windows ME/2000/XP).

Solution: CD/DVD Is Not Recognized (Windows® 2000/XP)

Many times, after inserting a disc into the CD or DVD drive, the disc is not recognized by that drive. CD-read and DVD-
read issues can

be caused by many sources. Perform the procedures presented in this General Computer Advice article when
troubleshooting CD-read

and DVD-read issues.

Begin with the first procedure and continue through the list. Try using the CD or DVD after each procedure is completed.
For any

procedure that requires changing current system settings, record the original settings before completing the procedure.

1.Verify that the correct disc (CD/DVD) is used when prompted to insert the disc.

2.For programs on DVD, verify that the drive containing the DVD is a DVD drive and not a CD-ROM drive. Most DVD
drives will

have DVD printed on the front of the drive. For programs on DVD, consider the following:

DVD drives can read both DVD’s and CD’s.

CD-ROM drives can read only CD’s.

3.1f multiple disc drives (e.g., CD-ROM and CD-RW, or DVD and DVD-RW, or CD-ROM and DVD-RW, etc.) exist on the
computer that can read the disc (refer to the items under Step 2), insert the CD or DVD into the other drive and try the
program again.

4.1f you are attempting to install a program and the installation does not begin after inserting the CD/DVD into the proper
drive, refer to the program’s instructions for the installation procedure, or try starting the installation in the following manner:

a.Close all programs and windows and return to the desktop.

b.Click Start, select Settings (Windows® 2000/XP Classic Start Menu) and click Control Panel.



c.Double-click the Add/Remove Programs icon (Windows® 2000/Windows® XP in Classic View). The

Add/Remove Programs window will open.

NOTE: For Windows® XP, if the Add/Remove Programs icon does not appear in the Control Panel, click

Classic View (on the left) and then double-click the Add/Remove Programs icon. The Add/Remove Programs window will
open.

d.Verify that the CD/DVD is in the correct drive and click the Add New Programs button (left).

e.Click the CD or Floppy button. The Install from Floppy Disk or CD-ROM window will open.

f.Click Next. Windows® will begin scanning the drives for any Setup or Install files. After the drives are

scanned, the install command will appear in the Open: line.

NOTE: If the Open: line is empty, stop here and continue with Step 5.

g.Click Finish. The installation should begin. h.Follow the program instructions to complete the installation.

5.Clean the CD/DVD in the following manner:

a.Place a small amount of nonabrasive liquid soap on the shiny side of the CD/DVD.

b.Using your fingertips and warm water, gently rub the soap on the CD/DVD in a circular motion.

c.Rinse the CD/DVD thoroughly and dry it using a clean, soft T-shirt or lint-free towel. (Do not use paper

towels or tissue paper.)

6.Verify that the most current version of the driver for the DVD or CD drive is being used. This is accomplished in the
following manner:

a.Close any open programs or windows and return to the desktop.

b.Right-click the My Computer icon and choose Properties from the menu that appears.

c.In the System Properties window, click the Hardware tab. d.Click Device Manager button. e.Click View and choose View
Devices By Type. f.In the list that appears, locate DVD/CD-ROM Drives or Controller.

g.Click the plus sign (+) next to this listing. The CD and/or DVD drive manufacturer and drive model number will appear
below the DVD/CD-ROM Drives listing. h.Double-click the name that appears. i.In the Properties window, select the Driver
tab. j.Record the information that appears.

k.Contact the computer or CD/DVD drive manufacturer and request information regarding the newest driver for the drive.
In most cases, information can be obtained at the web site of the computer or CD/DVD drive manufacturer.

NOTE: Do not click the Update Driver button. The Update Driver wizard searches the system (not the

Internet) for drivers to the selected device.

I.Download and install the new driver. m.Try the CD or DVD again.

7.Try to use a different CD or DVD in the drive to see if that disc can be read.

8.1f possible, insert the problem CD or DVD into the DVD or CD drive of another computer to see if the issue persists.

Error 'This Application cannot run’

Problem: When trying to start the program the following error mesage comes up "This Application cannot run"

Solution: Compatibility Mode
Try running the program in Windows XP Using Compatibility Mode.

Most programs run properly on Windows XP. The exceptions include some games and other programs that were written
specifically for an earlier version of Windows. The Program Compatibility Wizard can allow older programs to run on Windows
XP.

The Program Compatibility Wizard prompts you to test the program in different modes (environments) and with various
settings. For example, if the program was originally designed to run on Windows 95, set the compatibility mode to Windows
95 and try running the program again. If successful, the program will start in that mode each time. The wizard also allows the
use of different settings, such as switching the display to 256 colors and the screen resolution to 640 x 480 pixels.

The Program Compatibility Wizard provides step-by-step instruction for use. To run the Program Compatibility Wizard,
complete the steps below.

Note: Windows XP allows different options for viewing graphical interface. The following procedure assumes that the
default

Windows XP view settings are used, rather than the Classic Start Menu View.
1. Close programs, return to the desktop, and click Start on the Windows taskbar.
2. Click All Programs, choose Accessories and select Program Compatibility Wizard. The icon appears as a question
mark (?).
The Program Compatibility Wizard Welcome window will open.
3. Click Next.



4. Select the program that is to run in a Compatibility Mode.

5. Click Next. A window presenting the different Windows® Compatibility Modes will open.

6. Click the radio button next to the desired Compatibility Mode and click Next.

7. The window that appears allows for the selection of 256 Colors and/or 640 X 480 Pixel Screen Resolution.

Note: These display settings are not available options in Windows XP. They are only available when running a
program in Program Compatibility Mode. The only reason to choose either of these settings is if you are experiencing
difficulty installing or running an older application designed to run in MS-DOS, Windows 3.1 or Windows 95. If all options
remain unchecked, then the current Colors and Screen Resolution settings will not be altered.

By default, Windows XP uses visual themes that may change the appearance or behavior of other programs,
especially those games or educational programs that include intensive graphics and animation. To prevent the visual themes
from affecting these programs, check Disable Visual Themes.

8. Click Next. A window showing the heading "Test Your Compatibility Settings" will appear. In addition, the settings that
you selected will appear.
9. Verify that the settings are correct.

Note:If the settings are not correct, click the Back button to return to the previous screen (or screens) and make the
necessary changes.

10. With the correct settings selected and showing in the "Test Your Compatibility Settings" window, click Next. A screen
showing the following question will open: "Did the program work correctly?" In addition, the program selected in Step 5
(above) will launch.

11. Run the program to test the settings.

12. After testing the settings, minimize (or close) the program to return to the Program Compatibility Wizard.

Note: After the program is minimized (or closed), the window with the "Did the program work correctly?" question will
reappear.

The "Yes. Set this program to always use these compatibility settings" will be selected.

13. If the program functioned properly using the compatibility mode that was selected in Step 7 (above), click Next. The
Program Compatibility Data window will open.

Note: If the program did not function correctly, click "No, try different compatibility settings" and complete the Wizard.
After completing the wizard, try the program again.

In the window that opens, select Yes or No and click Next. The Completing the Program Compatibility Wizard window
will appear.

14. Click Finish to close the window.
15. Launch (if necessary) and use the program.

Note: If you have questions regarding the Program Compatibility Wizard or Windows XP (or both), contact Microsoft,
or go to http://www.microsoft.com for additional information.

'General Protection Fault' error

Problem: The program crashes with a General Protection Fault in module [product_name].exe

Solution: There are three probable alternative causes for this fault:

1. Dirty or scratched disc

2. Incorrect system date

3. Installation problems on the hard disc

The general procedure to follow is:

1. Clean the disc with a soft dry cloth and retry the product

2. Uninstall and reinstall the product

3. Check the system date on the computer (you can do this by double-clicking on the clock at the bottom right of the
screen)

4. Run Scandisk on the machine to fix any hard disc errors (click on START > PROGRAMS > ACCESSORIES >



SYSTEM TOOLS > SCANDISK)

Sound issues

Problem: There is no sound when you use the program.
How do | enable sound on my computer?

Solution: Check System Volume:
Go to:Start -->Programs -->Accessories -->Entertainment -->Volume control.Make sure that "Mute all" is not selected and
that "Mute" under '‘Wave' is not selected. Ensure that the volume is sufficient.

Check Game Settings:
Also check the settings within the game by left clicking on the "Sound" pull down menu. Make sure that there is a tick next
to both "Sound Effects"Speech.

Check Speaker Volume:
Also, see if the sound volume is turned up for the speakers
(if you have external speakers). Check to see if the external speakers are connected to the computer and are turned on
and getting power.

Windows XP Pro Settings:

To check the sound configuration on windows XP pro:

Double click on the "My computer" icon, then click on "Change a setting", then click on "Sound Speech and Audio
devices", then under "Pick a task", click on "Adjust the System Volume" click on the "Volume" tab and check the settings.

Also check the "Sounds" tab and set the "Sound scheme" to "Windows default” and clcik "Apply".

If all other settings look ok then click on the "Speaker settings" and check the "Speaker Volume and Advanced settings"
tab and click on "Performance tab", check the settings here and change them accordingly (if hardware accelerating is set to
high make it medium) and then click on "Apply" and "Ok".

Security/Permissions tab on Windows XP Pro

Problem:
* | can't view the Security tab on Windows XP Professional edition computer.

Solution: Step 1.
To view the security tab go to

o Start -->

o Settings -->

o Control Panels -->

0 Appearance and Themes -->

o Folder options.

o In the Folder options dialog box select the tab View and scroll down until you find "Use simple file sharing” and
unselect it.

o Click Apply followed by OK.

0 You should now be able to view the security tab goto step 4, otherwise goto to step 3.

Step 2.
If you still can't see the security tab then follow this step.
o Restart the computer in Safe Mode (this is is done by holding down the F8 key as soon as your computer is booting
up.
0 A menu should then appear, select safe mode from this menu.
o Login as the Administrator.



